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I. Description

The Plexor™ qPCR and qRT-PCR Systems(a,b) are compatible with a variety of real-
time PCR instruments. Data from these instruments can be analyzed with one
dedicated software program, the Plexor™ Analysis Software. This manual includes
instructions and thermal cycling conditions specific for use of the Plexor™ qPCR
System, Plexor™ Two-Step qRT-PCR System and Plexor™ One-Step qRT-PCR System
with the Bio-Rad iCycler iQ™ Real-Time PCR Detection System. Instructions are
included for instrument setup, data transfer from the instrument to the Plexor™
Analysis Software and data analysis.

II. Plate Preparation and Amplification

Detailed instructions describing assay setup are provided in the Plexor™ qPCR
System Technical Manual #TM262, Plexor™ One-Step qRT-PCR System Technical Manual
#TM263 or Plexor™ Two-Step qRT-PCR System Technical Manual #TM264.

When using the Plexor™ qPCR and qRT-PCR Systems for the first time, we
recommend programming the thermal cycling conditions, and checking that the
instrument is compatible with the dyes used and is configured for those dyes, before
assembling the reactions. This ensures that the reactions will not be kept on ice for
prolonged periods of time. Once you are familiar with the programming process, the
instrument can be programmed after reaction assembly.

Materials to Be Supplied By the User
• centrifuge capable of centrifuging a 96-well plate
• optical quality sealing tapes
• Bio-Rad 10X External Well Factor Solution

1. After the amplification reactions are assembled, cover the reaction plate with an
optical quality sealing tape. Centrifuge briefly to collect the contents at the
bottom of each well.
Note: Keep the plate on ice during reaction setup and programming of thermal
cycling conditions.

2. Program the Bio-Rad iCycler iQ™ Real-Time PCR Detection System. The proper
thermal cycling conditions and instructions for programming the instrument are
provided in Section III (qPCR and two-step qRT-PCR assays), Section IV (one-
step qRT-PCR assays) and Section V (genotyping assays).

Promega Corporation · 2800 Woods Hollow Road · Madison, WI  53711-5399 USA · Toll Free in USA 800-356-9526 · Phone 608-274-4330 · Fax 608-277-2516 · www.promega.com
Part# TM270 Printed in USA.

9/05Page 2Page 2

tm270.0905.qxp  10/7/2005  9:54 AM  Page 2



Promega Corporation · 2800 Woods Hollow Road · Madison, WI  53711-5399 USA · Toll Free in USA 800-356-9526 · Phone 608-274-4330 · Fax 608-277-2516 · www.promega.com
Printed in USA. Part# TM270
9/05 Page 3

III. Instrument Setup and Thermal Cycling for qPCR and Two-Step qRT-PCR

These instructions describe instrument setup and thermal cycling conditions for
DNA or cDNA quantitation using the Plexor™ qPCR or Plexor™ Two-Step qRT-
PCR Systems. Thermal cycling programs described in this manual are optimized to
work with primers designed using the Plexor™ Primer Design Software, which can
be accessed at: www.promega.com/plexorresources/. Instructions for data export
from the Bio-Rad iCycler IQ™  into the Plexor™ Analysis Software are provided in
Section VI.

III.A.Thermal Cycling Program

The thermal cycling program for qPCR and two-step qRT-PCR is shown in Table 1.
Primers designed using the Plexor™ Primer Design Software have an annealing
temperature of approximately 60°C. Figure 2 shows the final thermal cycling program.

Note: The Bio-Rad iCycler iQ™ performs a “well factor” collection process at the
onset of a run to normalize signal across a plate. Before starting a run (before cycling
begins), the iCycler iQ™ will require designation of the experimental plate (internal)
or an external “well factor plate” as the source of this data. Use of the “experimental
plate” (the simplest and recommended method) requires that the selected wells all
contain the same concentrations of dyes. If this requirement is not met, an external
well factor plate must be used. See Section IX.G and the user manual supplied with
the iCycler iQ™ instrument for more information on use of an external well factor
plate.

Table 1. qPCR and Two-Step RT-PCR Thermal Cycling Program.

!

Step Temperature Time Number of
Cycles

“Experimental
plate” well-factor

collection
Automatically inserted into program

Initial
denaturation 95°C 30 seconds1 1 cycle

Denaturation: 95°C 5 seconds
40 cyclesAnnealing and

extension: 60°C 35 seconds

Melt curve:

60°C initially,
increasing in

0.5°C
increments

8 seconds per
fluorophore
(i.e., 8, 16, 24

or 32s for 1, 2,
3 or 4 dyes,

respectively)

70 cycles

1This denaturation step should be extended to 2 minutes if an external well factor plate
is being used for the initial well factor collection step. See Section IX.G for more
information.
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1. Launch the iCycler iQ™ software.

2. Select the Library module. 

3. Select the “View Protocol” tab (Figure 1).

4. Select “Create a new protocol”.

5. The Workshop module will appear. Select the “Melt Curve” checkbox
from the “Show options:” panel (Figure 2).

6. Create the protocol shown in Figure 2 as follows:

• Use the “Insert Cycle”, “Delete Cycle”, “Insert Step” and “Delete Step”
buttons (Figure 2) to create a new protocol. To insert or delete a cycle or
step, select the appropriate button then select the position of the
cycle/step in the protocol table. Deselect the active button before directly
editing the cells.

• Directly edit cells by double-clicking on the desired cells (“Repeat”,
“Dwell Time”, “Setpoint”, “Melt Curve” and “+Temp”). 

• The “Dwell Time” for the final melt step must be 00:08s per dye used
(Figure2, bottom panel).

Note: The repeat number for the final melt step must be entered before the
“Melt Curve” box can be checked.

If an external well factor plate is used, the initial denaturation time must be
extended to 2 minutes. See Section IX.G for further details.

7. In the “Select data collection step(s)” panel, select “Cycle 2, Step 2” and
“Cycle 3, Step 1” for data collection (if not already indicated) by double-
clicking the desired Step (a camera icon indicates that a step is selected for
data collection; Figure 2).

8. Name the protocol by entering a name in the “Protocol Filename” box. Save
the protocol by selecting the “Save this protocol” button and then selecting
“Save” in the “Saving a Protocol” window that appears.

9. Select “Run with selected plate setup”. 
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Figure 1. The “View Protocol” tab in the Library module.
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III.B. Plate Setup

1. Select the “Library” module. 

2. Select the “View Plate Setup” tab.

3. Select the “Create a new plate setup” button.

4. In the “Edit Plate Setup” window that appears, select the “Whole Plate
loading” tab (instead of the “Per Dye Layer” mode) (Figure 3) .

5. Select “Unknown” from the sample type icons.

6. Select the wells to be used.

7. Click on the “Select and load fluorophores” tab.

8. Select or deselect the dyes being used from the “Select and load
fluorophore” panel. After each dye is selected assign a different color from
the four colors listed (Figure 4).

9. Select a fluorophore pen and then select the wells using this fluorophore.
Repeat for each dye being used. 

If all of the wells in use do not have the same dyes designated, an external
well factor plate must be used. See Section IX.G for more information. 

10. Enter a name in the “Plate Setup Filename” box (Figure 3). Save the plate
setup by selecting “Save this plate setup” and then selecting “Save” in the
“Saving a Plate Setup” window that appears.

11. Select “Run with selected protocol”.

Figure 2. The Selecting the “Melt curve” in the Workshop module.
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25

TA

8 seconds required per dye.
(i.e., time must be increased

if multiple dyes are used)
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Figure 4. The “Select and load fluorophores” tab in the “Edit Plate Setup” window.
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Figure 3. The “Whole Plate Loading” tab in the “Edit Plate Setup” window.
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12. The “Run Prep” window will open (Figure 5). Enter a sample volume of
25µl and check that the “Experimental Plate” radio button is selected
under the “Select well factor source” option (unless you are using an
external well-factor plate as described in Section IX.G).

13. Place the PCR plate into the instrument and immediately begin thermal
cycling by selecting “Begin Run”.

Prolonged exposure of the reactions to high temperatures berfore thermal
cycling may adversely affect the final results.

Figure 5. The “Run Prep” window. 

!
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IV. Instrument Setup and Thermal Cycling for One-Step qRT-PCR

These instructions describe instrument setup and thermal cycling conditions for
cDNA quantitation using the Plexor™ one-step qRT-PCR System. The thermal
cycling program includes the initial incubation for the reverse transcription.

IV.A. Thermal Cycling Program

The one-step qRT-PCR thermal cycling program is shown in Table 2. Primers
designed using the Plexor™ Primer Design Software have an annealing temperature
of approximately 60°C. Figure 7 shows the final thermal cycling program.

Note: The Bio-Rad iCycler iQ™ performs a “well factor” collection process at the
onset of a run to normalize signal across a plate. During the final steps of starting a
run (before cycling begins), the iCycler iQ™ will require designation of the
experimental plate (internal) or an external “well factor plate” as the source of this
data collection. The high temperature of this process is not compatible with the
reverse transcriptase enzyme, therefore, an external well factor plate (and subsequent
selection) must be analyzed before the experimental plate is inserted into the iCycler
iQ™ instrument. See Section IX.G and the user manual supplied with the iCycler IQ™
instrument for more information on use of an external well factor plate.

1. Launch the iCycler iQ™ software.

2. Select the “Library” module. 

3. Select the “View Protocol” tab (Figure 6).

Table 2. One-Step qRT-PCR Thermal Cycling Program.
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!

Step Temperature Time Number of
Cycles

Reverse transcription reaction 45°C 5 minutes1 1 cycle

Initial denaturation and
inactivation of the ImProm-II™

Reverse Transcriptase
95°C 2 minutes 1 cycle

Denaturation: 95°C 5 seconds
40 cycles

Annealing and extension: 60°C 35 seconds

Melt curve:

60°C
initially,

increasing in
0.5°C

increments

8 seconds per
fluorophore
(i.e., 8, 16, 24
or 32s for 1,

2, 3 or 4
dyes,

respectively)

70 cycles

1The length of incubation for the reverse transcription reaction can be increased to up to 30 minutes. Longer incubation
times can lead to increased sensitivity but also higher background.
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4. Select the “Create a new protocol” button.

5. The Workshop module will appear. Select the “Melt Curve” checkbox from the
“Show options:” panel (Figure 7).

6. Create the protocol shown in Figure 7 as follows:
• Use the “Insert Cycle”, “Delete Cycle”, “Insert Step” and “Delete Step” buttons

(Figure 7) to create a new protocol. To insert or delete a cycle or step, select the
appropriate button then select the position of the cycle/step in the protocol
table. Deselect the active button before directly editing the cells.

• Directly edit cells by double-clicking on the desired cells (“Repeat”, “Dwell
Time”, “Setpoint”, “Melt Curve” and “+Temp”).  

• The “Dwell Time” for the final melt step must be 00:08s per dye used (Figure 7,
bottom panel).

Note: The repeat number for the final melt step must be entered before the “Melt
Curve” box can be checked.

7. In the “Select data collection step(s)” panel, select “Cycle 3, Step 2” and “Cycle 4,
Step 1” for data collection (if not already indicated) by double-clicking the desired
Step (a camera icon indicates that a step is selected for data collection; Figure 7).

52
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Figure 6. The “View Protocol” tab in the Library module. 

Figure 7. Selecting the “Melt Curve” in the Workshop module. 
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8 seconds required per dye.
(i.e., time must be increased

if multiple dyes are used)
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8. Name the protocol by entering a name in the “Protocol Filename” box. Save
the protocol by selecting the “Save this protocol” button and then selecting
“Save” in the “Saving a Protocol” window that appears.

9. Select the “Run with selected plate setup” button. 

IV.B. Plate Setup

1. Select the “Library” module. 

2. Select the “View Plate Setup” tab.

3. Select the “Create a new plate setup” button.

4. In the “Edit Plate Setup” window that appears, select the “Whole Plate
loading” tab (instead of the “Per Dye Layer” mode) (Figure 8).

5. Select “Unknown” from the sample type icons.

6. Select the wells to be used.

7. Click on the “Select and load fluorophores” tab.

8. Select or deselect the dyes being used from the “Select and load
fluorophore” panel. After each dye is selected, assign a different color from
the four colors listed (Figure 9).

9. Select a fluorophore pen and then select the wells using this fluorophore.
Repeat for each dye being used. 

10. Enter a name in the “Plate Setup Filename” box (Figure 8). Save the plate
setup by selecting “Save this plate setup” and then selecting “Save” in the
“Saving a Plate Setup” window that appears.

11. Select “Run with selected protocol”.
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Figure 8. The “Whole Plate Loading” tab in the “Edit Plate Setup” window.
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12. The “Run Prep” window will open (Figure 10). Enter a sample volume of
25µl and select the “Well Factor Plate” radio button under the “Select well
factor source” option.

13. Create an external well factor plate as described in Section IX.G.

14. Seal the external well factor plate and centrifuge briefly.
15. Place the well factor plate into the instrument and immediately begin the

run by pressing the “Begin Run” button. Keep the experimental plate on ice.
Prolonged exposure of the reactions to high temperatures berfore thermal
cycling may adversely affect the final results.

16. After several minutes, you will be prompted to remove the well factor
plate and insert the experimental plate. Select “continue” when the
experimental plate has been placed in the instrument and the lid has 
been closed.

52
27
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Figure 9. The “Select and load fluorophores” tab in the “Edit Plate Setup” window.

Figure 10. The Run Prep window.
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V. Instrument Setup and Thermal Cycling for Genotyping (SNP) Assays

These instructions describe instrument setup and thermal cycling conditions for
genotyping assays using the Plexor™ qPCR System. This cycling program is specific
for genotyping primers designed using the Plexor™ Primer Design software. 

V.A. Thermal Cycling Program

The thermal cycling program is shown in Table 3. Each of the genotyping primers
includes bases that are not complementary to the target sequence at the 5´ end. The
annealing temperature for the first round of amplification is 50°C to allow the
primer to anneal and be extended. Subsequent rounds are performed using an
annealing temperature of 60°C, which is the melting temperature (Tm) of the primer
pair including the noncomplementary bases. During subsequent rounds of
amplification, performed at the higher annealing temperature, the target formed in
the first round is amplified. Figure 12 shows the final thermal cycling program. 

Table 3. Thermal Cycling Profile for Genotyping Assays.

Step Temperature Time Number of
Cycles

“Experimental
plate” well-factor

collection
Automatically inserted into program

Initial
denaturation 95°C 30 seconds1 1 cycle

Annealing and
extension: 50°C 35 seconds 1 cycle

Denaturation: 95°C 5 seconds
40 cycles

Annealing and
extension: 60°C 35 seconds

Melt curve:

60°C initially,
increasing in

0.5°C
increments

8 seconds per
fluorophore

(i.e., 16s for 2
dyes)

70 cycles

1This denaturation step should be extended to 2 minutes if an external well factor plate
is being used for the initial well factor collection step. See Section IX.G for more
information.
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Note: The Bio-Rad iCycler iQ™ performs a “well factor” collection process at the
onset of a run to normalize signal across a plate. Before starting a run (before cycling
begins), the iCycler IQ™ will require designation of the experimental plate (internal)
or an external “well factor plate” as the source of this data. Use of the “experimental
plate” (the simplest and recommended method) requires that the selected wells all
contain the same concentrations of dyes. If this requirement is not met, an external
well factor plate must be used. See Section IX.G and the user manual supplied with
the iCycler iQ™ instrument for more information on use of an external well factor
plate.

1. Launch the iCycler iQ™ software.

2. Select the “Library” module. 

3. Select the “View Protocol” tab (Figure 11).

4. Select the “Create a new protocol” button.

5. The “Workshop” module will appear. Select the “Melt Curve” checkbox
from the “Show options:” panel (Figure 12).

6. Create the protocol shown in Figure 12 as follows:

• Use the “Insert Cycle”, “Delete Cycle”, “Insert Step” and “Delete Step”
buttons (Figure 12) to create a new protocol. To insert or delete a cycle or
step, select the appropriate button then select the position of the
cycle/step in the protocol table. Deselect the active button before directly
editing the cells.

• Directly edit cells by double-clicking on the desired cells (“Repeat”,
“Dwell Time”, “Setpoint”, “Melt Curve” and “+Temp”).  

• The “Dwell Time” for the final melt step must be 00:08s per dye used.
Note: The repeat number for the final melt step must be entered before the
“Melt Curve” box can be checked.
If an external well factor plate is used, the initial denaturation time must be
extended to 2 minutes.

7. In the “Select data collection step(s)” panel, select “Cycle 2, Step 2” and
“Cycle 3, Step 1” for data collection, if not already indicated, by double-
clicking the desired Step (a camera icon indicates that a step is selected for
data collection; Figure 12).

!

!
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Figure 11. The “View Protocol” tab in the Library module.
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Figure 12. The selecting the 'Melt Curve' in the Workshop module.
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8 seconds required per dye.
(i.e., time must be increased

if multiple dyes are used)
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8. Name the protocol by entering a name in the “Protocol Filename” box. Save
the protocol by selecting the “Save this protocol” button and then selecting
the “Save” button in the “Saving a Protocol” window that appears.

9. Select the “Run with selected plate setup” button. 

V.B. Plate Setup

1. Select the “Library” module. 

2. Select the “View Plate Setup” tab.

3. Select the “Create a new plate setup” button.

4. In the “Edit Plate Setup” window that appears, select the “Whole Plate
loading” tab (instead of the “Per Dye Layer” mode).

5. Select “Unknown” from the sample type icons (Figure 13).

6. Select the wells to be used.

7. Click on the “Select and load fluorophores” tab.

8. Select or deselect the dyes being used from the “Select and load
fluorophore” panel. After each dye is selected assign a different color from
the four colors listed (Figure 14).

9. Select a fluorophore pen and then select the wells using this fluorophore.
Repeat for each dye being used. 

If all of the wells in use do not have the same dyes designated, an external
well factor plate must be used. See Section IX.G for more information. !
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10. Enter a name in the “Plate Setup Filename” box (Figure 13). Save the plate
setup by selecting “Save this plate setup” and then selecting “Save” in the
“Saving a Plate Setup” window that appears.

11. Select “Run with selected protocol”.

12. The “Run Prep” window will open (Figure 15). Enter a sample volume of
25µl and check that the “Experimental Plate” radio button is selected
under the “Select well factor source” option (unless you are using an
external well-factor plate as described in Section IX.G).

13. Place the PCR plate into the instrument and immediately begin thermal
cycling by selecting “Begin Run”.

Prolonged exposure of the reactions to high temperatures before thermal
cycling may adversely affect the final results.

52
26

TA

Figure 13. The “Whole Plate Loading” tab in the “Edit Plate Setup” window.

!
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Figure 14. The “Select and load fluorophores” tab in the “Edit Plate Setup” window.

Figure 15. The “Run Prep” window. 
52
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VI. Data Export from the iCycler iQ™ and Import into the Plexor™ Analysis Software

Data may be transferred from the iCycler iQ™ to the Plexor™ Analysis Software in
two ways. The recommended method is to directly copy and paste data from the
iCycler iQ™ software into the Plexor™ Analysis Software (Section VI.A). However,
this method requires that the Plexor™ Software be installed on the instrument
workstation. Alternatively, data may be copied and pasted the iCycler iQ™ into
Microsoft® Excel. The Excel files are saved, and then imported into the Plexor™
Analysis software (Section VI.B).

VI.A. Pasting Data Directly into the Plexor™ Software

This method requires that the iCycler iQ™ Software and the Plexor™ Analysis
Software both be open on the instrument workstation. The Plexor™ Analysis
Software (Cat.# A4071) is available for download at:
www.promega.com/plexorresources/. The software is also available free-of-charge
on CD-ROM. Software installation instructions are given in Section IX.B.

Note: Two sets of data (one for the amplification data and one for the melt data)
must be copied from the iCycler iQ™ and pasted into the Plexor™ Analysis
Software. This must be repeated for each dye used.

1. Launch the Plexor™ Analysis Software, go to the “Start” menu and select
“Programs”, then “Plexor”; then select “Analysis Desktop”.
Note: A shortcut can be placed on the desktop by right-clicking on
“Analysis Desktop”, selecting “Copy”, then right-clicking on the Windows
desktop and selecting “Paste Shortcut”.

2. In the “File” menu, select “Import New Run” or select the icon:

3. Optional: Enter an assay name in the “Assay Setup” screen, Step 1 (Figure
16). This screen is used to enter general information about the type and
format of the data that will be used for each assay.

4. Select “Bio-Rad iCycler iQ (via paste)” as the instrument type.

5. Select “Add Target” for each fluorescent dye used in your assay. For each
dye, assign a target name, enter the dye name and indicate that there is
amplification data and dissociation (melt) data to be analyzed for that dye.
Note: For frequently run assays, a template with the target information
and dyes can be saved (Section IX.C).

6. Select “Next”.

7. Enter information specific to your experiment in the “Run Info” screen,
Step 2 (Figure 17). Other details (date, notes, title, name of the person
performing the experiment, etc.) can also be entered in the provided
windows.
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Figure 16. The Assay Setup screen.

Figure 17. The Run Info screen.
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8. Select “Next”.
Use the “File Import” screen, Step 3 (Figure 18), to paste data exported
(copied) from the iCycler iQ™ as described in Steps, 9–23, below.
Note: “Advanced Options” can be used to create templates for routine
plate setups and analysis conditions. See Section XI.C for details
concerning these advanced options and an explanation of the default
analysis settings.

9. In the iCycler iQ™ software, select the “Library” module. 

10. Select the “View Post-Run Data” tab (Figure 19).

11. Highlight the data/run file (*.opd) from the “Data Files” list.
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Figure 18. The File Import screen.
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Figure 19. The “View Post-Run Data” tab, in the Library module.
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Figure 20. The “PCR Quantification” tab with data displayed and all data selected.
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12. Select the “Analyze Data” button.

13. Within the “Data Analysis” module that opens, select the “PCR
Quantification” tab.

14. Select “Background Subtracted” from the “Select analysis mode:” drop-
down menu (Figure 20).

15. Highlight a fluorophore pen from the “Select a Fluorophore” list.

16. Right-click on the amplification curves graph and choose “Display Data”.
This will display a table in a small frame called “Data Display” located
above the amplification curves graph.

17. Left-click on the cell labeled “Well/Cycle” to select all data in the “Data
Display” table.

18. Press “Control C” to copy the data from the iCycler iQ™ software.

19. In the Plexor™ Analysis Software, select the blank cell shown in the
amplification section of the ” File Import” screen for the appropriate dye
(see Figure 18) and select the “Paste From Clipboard” button.

20. In the iCycler iQ™ software, select a different fluorophore pen and repeat
Steps 15-19 for each dye used.
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21. To export the melt data, go to the “Melt Curve” tab of the “Data Analysis”
module in the iCycler iQ™ software (Figure 21).

22. Highlight a fluorophore pen from the “Select a Fluorophore” list. 

23. Once the melt curve graph is shown, select the “–dF/dT vs Temperature”
tab to display the melt derivative.

24. Right-click on the melt curves graph and select “Display Data”. This will
display a table in a small frame called “Data Display” above the melt
curves graph. 

25. Left-click on the cell labeled “Well/Temp” to select all data in the “Data
Display” table.

26. Copy the data from the iCycler iQ™ software.

27. In the Plexor™ Analysis Software, select the blank cell shown in the
amplification section of the ” File Import” screen for the appropriate dye
(see Figure 18) and select the “Paste From Clipboard” button.

28. In the iCycler iQ™ software, select a different fluorophore pen and repeat
Steps 23-27 for each dye used.

29. When tables have pasted selections in the Plexor Analysis™ Software
(Figure 18), select “Finish” to complete data import and to open the
“Analysis Desktop”.
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Figure 21. The “Melt Curve” tab with data displayed and all data selected.

tm270.0905.qxp  10/7/2005  9:55 AM  Page 21



!

52
35

TA

Figure 22. The “View Post-Run Data” in the Library module.

VI.B. Data Export and Import via Excel

The Plexor™ Analysis Software (Cat.# A4071) is available for download at:
www.promega.com/plexorresources/. It is also available free-of-charge on CD-ROM
by request. Software installation instructions are given in Section IX.B.
Note: Two files (one for the amplification data and one for the melt data) must be
exported for each dye used in the run.

1. In the iCycler iQ™ software, select the “Library” module.

2. Select the “View Post-Run Data” tab (Figure 22).

3. Highlight the data/run file (*.opd) from the “Data Files” list.

4. Select the “Analyze Data” button.

5. Within the “Data Analysis” module that opens, select the “PCR
Quantification” tab.

6. Select “Background Subtracted” from the “Select analysis mode:” drop-
down menu (Figure 23).

7. Highlight a fluorophore pen from the “Select a Fluorophore” list.

8. Right-click on the amplification curves graph and choose “Display Data”.
This will display a table in a small frame called “Data Display” located
above the amplification curves graph.

9. Left-click on the cell labeled “Well/Cycle” to select all data in the “Data
Display” table.
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10. Copy the data from the iCycler iQ™ software.

11. Open a new Excel spreadsheet, select well A1 and paste the values into the
spreadsheet.

12. Save this spreadsheet as a *.txt (tab delimited) file with a name that
describes the dye and indicates that it is an amplification data set (i.e.,
“Plexor FAM amp.txt”).

13. Select a different fluorophore pen and repeat steps 7-12 for each dye used.

14. To export the melt data, go to the “Melt Curve” tab of the “Data Analysis”
module.

15. Highlight a fluorophore pen from the “Select a Fluorophore” list. 

16. Once the melt curve graph is shown, select the “–dF/dT vs Temperature”
tab to display the melt derivative.

17. Right-click on the melt curves graph and select “Display Data”. This will
display a table in a small frame called “Data Display” above the melt
curves graph. 

18. Left-click on the cell labeled “Well/Temp” to select all data in the “Data
Display” table.
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Figure 23. The “PCR Quantification” tab with data displayed and all data selected.
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Figure 24. The “Melt Curve” tab with data displayed and all data selected.
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19. Copy the data from the iCycler iQ™ software.

20. Open a new Excel spreadsheet, select well A1 and paste the values into the
spreadsheet.

21. Save this spreadsheet as a *.txt (tab delimited) file with a name that
describes the dye, and indicates that it is a melt curve data set (i.e., Plexor
FAM melt.txt). 

22. Select a different fluorophore pen and repeat Steps 7–12 for each dye used.

23. Transfer the *.txt files onto removable storage media or to an accessible
network location for data transfer. These files are now ready for use with
the Plexor™ Analysis Software.

24. To launch the Plexor™ Analysis Software, go to the “Start” menu and
select “Programs”, then “Plexor”; then select “Analysis Desktop”.
Note: A shortcut can be placed on the desktop by right-clicking on
“Analysis Desktop”, selecting “Copy”, then right-clicking on the Windows
desktop and selecting “Paste Shortcut”.

25. In the “File” menu, select “Import New Run” or select the icon: 

26. Optional: Enter an assay name in the “Assay Setup” screen, Step 1 (Figure
25). This screen is used to enter general information about the type and
format of the data that will be used for each assay.
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27. Select “Bio-Rad iCycler iQ” as the “Instrument”.

28. Select “Add Target” for each fluorescent dye used in your assay. For each
dye, assign a target name, enter the dye name and indicate that there is
amplification data and dissociation (melt) data to be analyzed for that dye. 
Note: For frequently run assays, a template with the target information
and dyes can be saved (Section IX.C).

29. Select “Next”.

30. Enter information specific to your experiment in the “Run Info” screen,
Step 2 (Figure 26). Details (date, notes, title, name of the person
performing the experiment, etc.) can be entered in the provided windows.

31. Select “Next”.
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Figure 25. The Assay Setup screen.
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Figure 26. The Run Info screen.
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32. Use the “File Import” screen, Step 3 (Figure 27), to specify the Excel data
files exported from the instrument (see Steps 1–23). Use “Browse” to locate
the appropriate exported amplification and melt (dissociation) data files. 
When analyzing data with the Plexor™ Analysis Software, be sure to
choose the amplification and melt curve files generated using the same
data. The file names assigned when exporting data must be descriptive, so
the appropriate files can be easily identified and imported into the
Plexor™ Analysis Software.

Note: “Advanced Options” can be used to create templates for routine
plate setups and analysis conditions. See Section IX.C for details
concerning these advanced options and an explanation of the default
analysis settings.
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33. Select “Finish” to complete the data import and to open “Analysis
Desktop”.
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Figure 27. The File Import screen.
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VII. Data Analysis with the Plexor™ Analysis Software

After data import is complete (Section VII), the “PCR Curves” tab of the “Analysis
Desktop” is displayed (Figure 28).

VII.A. Sample Definition

1. Use the well selector, which is shown in Figure 28, to select and define each
well or group of wells. Choose one of the icons shown in Figure 29 to define
the samples. See Notes 1–5.

2. To assign sample names, select the “Sample IDs” tab (Figure 30). To enter
sample names manually, select the well, and enter the desired sample
name. Repeat to enter sample names for other wells.

To copy names from a MicroSoft® Excel spreadsheet, highlight the sample
names in the spreadsheet and select “copy”. In the “Edit” menu, select
“Paste Sample IDs from Template” or use the control T shortcut. The
layout of the sample names in the spreadsheet must be the same as the
layout of the samples within the PCR plate.
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Tab Selection

Amplification
urves Window

Melt Curves
Window

Well Selector

Tools

Graph Legend

Figure 28. The PCR Curves tab of the analysis desktop. The amplification curves window, melt
curves window and well selector are indicated.

!
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Notes:
1. Sample definitions, color selection and concentration of standards will

be entered for all dyes. To define samples separately in each dye,
uncheck “Propagate Selection Across Dyes” in the “Edit” menu.

2. A sample or set of samples can be permanently deleted from a Plexor™
analysis. Go to the PCR Curves tab, and select the samples. Use the
delete key or select “Remove Selected Wells” in the “Edit” menu.

3. All samples defined as standard reference templates must be assigned a
concentration. Concentrations may be entered in standard format (0.01,
0.1, 1, 10, 100, 1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3,
etc.). Standard reference templates with the same concentration may be
assigned simultaneously by highlighting multiple wells. The software
does not accept commas in the concentration assignments.

Unknown

No-template control

Standard sample. The concentration is entered in a pop-up window
following designation of a well as a standard.
Selecting the wells and choosing the “Create Dilution Series” icon can
automatically create a titration curve across several wells.

Positive control

Color assignment

Figure 29. The icons used to define samples in the Plexor™ Analysis Software.

50
48

TA
Figure 30. The Sample IDs tab.
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4. A row or column of contiguous wells within a dilution series of standard
reference templates may be simultaneously assigned as standards using the
“Assign Dilution Series” function by highlighting multiple wells (Figure 31). You
must enter the initial concentration of the series, the dilution factor and whether
the series is increasing or decreasing.

5. Colors can be assigned to samples to provide distinction to the displayed data.
Select the samples, then select “color assignment” to apply a color to the selected
sample(s).
Assigning or changing a color does not alter the information associated with a
sample. For example, the concentrations of standard samples will be retained if
the display color associated with those samples is changed.

VII.B. Adjusting the Expected Target Melt Temperature

Set the expected target melt temperature and the expected target melt temperature
range. Failure to set the range for the expected target melt temperature correctly will
cause the results to be incorrectly reported in the graph legend and the “Reports”
tab (Section VII.F.). For multiplex assays, the expected melt temperature range must
be adjusted for each dye.

1. Select the “PCR Curves” tab. The default setting for the expected target
melt temperature is 90.0, and the default target Tm range is +/–1°C.

2. Select a well containing a standard reference template or genotyping control
sample. The Tm for each selected sample will be displayed in a table to the
right of the graph (Figure 32). The expected target melt temperature and
associated target melt temperature range for all samples in this dye
channel should be set based on the Tm of this standard or control sample.
See Note 1.

3. In the melt curves window, move the mouse so the arrow is over the
expected target melt temperature line, and drag it to the desired
temperature. Alternatively, double-click on the line, and enter the desired
temperature. See Notes 2–5.
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Figure 31. The Assign Dilution Series screen.
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4. Optional: The melt threshold may be reset to change the sensitivity in
detecting the amplification product. See Note 6. The default melt threshold
is set at 25% of the signal change for the sample within the set that has the
greatest change in signal. In some instances, the sample(s) used to set this
threshold may not be typical of the data set.
To adjust the melt threshold line based on a selected set of samples,
highlight the desired samples in the well selector. In the “Edit” menu,
select “Set Melt Threshold From Selected Samples”. Enter the desired
percentage of signal change.
To manually adjust the melt threshold line, place the cursor over the
threshold line, and drag the line to the desired location. Alternatively,
double-click on the threshold line, and enter the desired threshold value.

Notes:

1. No peaks for the standard reference template or genotyping control sample
indicates amplification problems. See Section VIII for more information
about possible causes.

2. The target melt temperature range can be adjusted manually. Move the
mouse so the arrow is over the upper or lower limit, and drag the limit to
the desired temperature. Alternatively, upper and lower limits can be
adjusted by double-clicking on the appropriate lines and entering an exact
value in the pop-up window that appears.

3. The melt threshold is the level of signal that must be reached for the
Plexor™ Analysis Software to “call” the melt results. Target Tm indicators
are included in the table to the right of the amplification and melt curve
windows.
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Graph Legend showing
Sample Tm and

Target Tm indicators

Melt Threshold

Figure 32. The expected target melt temperature is displayed in a table to the right of the graph.
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4. A “Yes” or “No” in the “Tm?” column indicates whether a sample Tm is
within the expected target melt temperature range. A “No Call” in this
column indicates the melt curve displays the correct expected target melt
temperature, but there is insufficient amplification product to cause the
amplification curve to cross the melt threshold.

5. The “Tm#” is the number of peaks that cross the melt threshold line. More
than one peak indicates heterogeneous amplification products. This may
be due to nonspecific amplification, secondary structure or a polymorphic
target. See Section VIII for more information about possible causes.

6. Changes made to the melt threshold line will apply to the entire data set
within the same dye channel, including those samples that were not
selected.

VII.C. Adjusting the Y Axes of the Amplification and Thermal Melt Curves 
(Optional)

The scales of the Y axes for the amplification curve and melt curve in an experiment
are determined by the sample that yields the most amplification product (i.e., the
sample with the greatest decrease in signal). These scales are set for the entire data set.

The scale of the Y axis can be set manually by double-clicking on the Y axis of the
graph and entering the new value in the pop-up window. This change will alter the
scale for the entire data set.

VII.D. Adjusting the Baseline Region and Amplification Threshold Line (Optional)

The Plexor™ Analysis Software automatically sets the baseline region for each
sample. The baseline is set in a flat region of the amplification curve before product
accumulation. Manual adjustment of baseline is possible. See Section IX.D. for
information on display and adjustment of baseline regions.

The amplification threshold is used to determine the Ct value for the samples
(Figure 33). The default amplification threshold is based on the variation (noise) in
the baseline regions of all samples. It is determined by taking the mean and
standard deviation of all RFU values in the baseline regions and setting the
threshold to 10 standard deviations below the mean.

Optional: If desired, the amplification threshold may be reset to change the
sensitivity in detecting the amplification product.
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Amplification
Threshold

Figure 33. The amplification and melt thresholds.

1. To adjust the amplification threshold based on a selected set of samples,
highlight the desired samples in the well selector. In the “Edit” menu,
select “Set Amp Threshold From Selected Samples”. Enter the number of
standard deviations of the background within the baseline region to use.
The default is 10 standard deviations.

2. To manually adjust the threshold, place the cursor over the threshold, and
drag the line to the desired location. Alternatively, double-click on the
threshold, and enter the desired value.
Note: Changes made to the amplification threshold will apply to the entire
data set within the same dye channel, including those samples that were
not selected.

The baseline and threshold reset button will reset the amplification
threshold to the default using all samples.

VII.E. Generating a Standard Curve (Optional)

Amplification results from a dilution series of the standard reference template are
used to generate a standard curve. This standard curve can be used to determine the
concentration of unknown samples. A standard reference template with any unit of
concentration or amount can be used to generate the standard curve. In general, copy
number or mass is used, but other units that are appropriate for your experiment,
such as plaque forming units or dilution factors from a known stock, can be used.
Samples for generating the standard curve must be designated as standards (Section
VII.A.). For multiplex assays, standard curves must be generated for each dye label.

1. Select the desired standard samples and the samples you want to quantify.
Select “Add Standard Curve” to generate a standard curve.

Add standard curve
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2. Select the “Standard Curves” tab to view the standard curve (Figure 34).
The default display shows the log concentration on the Y axis and the
cycle threshold on the X axis.

Alternatively the standard curve can be displayed with the cycle threshold
on the Y axis and the log of the concentration on the X axis (Figure 35). To
do so, select the “Standard Curves” tab to view the standard curve. In the
“Edit” menu, select “Flip Std. Curve Axes”. See Notes 1 and 2.

3. View the concentrations for all samples, including the unknown samples,
in the table next to the standard curve graph (Figures 34 and 35). The
calculated concentrations can also be viewed in the sample details report
(Section VII.F.).

4. Repeat Step 1 with any other desired set of standards and samples.

Notes:

1. A second standard curve can be created using a different set of samples.
Repeat Step 1 using the new set of standard samples. Multiple standard
curves may be created within the same data set if none of the samples and
standards are shared.

If you attempt to generate an additional standard curve using samples that
are used in the current standard curve, the alert box “Confirm Standard
Curve Replace” will appear. The currently assigned standard curve will be
overwritten with the new standard curve if “OK” is selected.

2. An existing standard curve can be changed or additional unknowns added.
To do so, delete the existing standard curve. Go to the “Standard Curves”
tab, then select “Remove a Standard Curve”. The “Remove a Standard
Curve” button is only active in the “Standard Curves” tab.

Remove standard curve.
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Note: Samples that do not cross the amplification threshold, such as the no-template
controls, are listed in the graph as not having a valid Ct value.
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Figure 34. The Standard Curves tab. A standard curve with the log concentration on the Y axis and
the cycle threshold on the X axis.
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Figure 35. A standard curve with the cycle threshold on the Y axis and the log concentration on the
X axis.
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VII.F. Reports

The Plexor™ Analysis Software includes 5 report options: “Sample Details”,
“Thresholds”, “Baseline Regions”, “Run Info” and “Import Files”, which are included
as subtabs in the “Reports” tab. To view these report options, select the “Reports”
tab. Information is presented in a tabular format that can be copied, saved or printed
using the provided icons. The saved data can be opened using Microsoft® Excel.

For multiplex assays, the Plexor™ Analysis Software reports include information for
all of the dye labels.

Sample Details: The sample details report includes well location, sample ID, dye
channel, cycle threshold, thermal melt temperature, concentration (if applicable),
whether the sample has the expected Tm and the number of melt curves that cross
the melt threshold line (Figure 36).

A sample with a Ct value of “N/A” has an amplification curve that did not cross the
amplification threshold.

Thresholds: The thresholds report includes the numerical values for the thresholds in
the current analysis (Figure 37). This information can be used to develop an analysis
template for assays where the same or similar thresholds will be used on a routine
basis. See Section IX.C. for more information about creating an analysis template.
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Figure 36. The Sample Details tab.
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Figure 37. The Thresholds tab.

tm270.0905.qxp  10/7/2005  9:56 AM  Page 36



Promega Corporation · 2800 Woods Hollow Road · Madison, WI  53711-5399 USA · Toll Free in USA 800-356-9526 · Phone 608-274-4330 · Fax 608-277-2516 · www.promega.com
Printed in USA. Part# TM270
9/05 Page 37

Baseline Regions: The baseline regions report includes the numerical values for the
cycle number used in each sample (Figure 38).

Run Info: The run info report includes the information from the data import
(Figure 39).

Import Files: The Import Files report includes information on the data import files
(Figure 40).
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Figure 38. The Baseline Regions tab.
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Figure 39. The Run Info tab.
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Figure 40. The Import Files tab.
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VII.G. Saving and Printing the Analysis File

1. The Plexor™ Analysis Software saves the analysis as an *.aan file. The
current analysis can be saved at any time by selecting “Save Analysis File
(.aan)” in the “File” menu.

2. Selected wells can be exported into a new analysis file. In the “File” menu,
select “Export Selected Wells as New Analysis File (*.aan)”.

3. The analysis screen can be printed or saved as a screenshot. In the “File”
menu, select “Save a Screenshot (.png)” or “Print a Screenshot”.

4. A Run Template and Analysis Template from an existing analysis can be
exported and used in future analyses (Section IX.C.).

VIII. Troubleshooting

Symptoms Causes and Comments
Flat amplification curve in the Template was degraded or of insufficient quantity. Verify the 
amplification curves window integrity of the DNA or RNA template by electrophoresis. 
(no apparent amplification) Repeat the DNA or RNA purification if necessary. Add 

RNasin® Ribonuclease Inhibitor to the reaction to inhibit a 
broad spectrum of RNases.
Amplification inhibitor is present in the DNA or RNA template.
Reduce the volume of template in the reaction. Repeat the 
DNA or RNA purification if necessary.

Add the template in question to the positive control reaction; 
a significant increase in the Ct value or no amplification in the 
positive control reaction indicates the presence of inhibitors in 
the template.
Be sure that the reactions were assembled correctly (see the 
Technical Manual supplied with the Plexor™ System).
Thermal cycler was programmed incorrectly. Verify cycle times
and temperatures (Section III, IV or V).
Data collection settings were incorrect. Data collection must 
occur during the extension step. The extension time must be 
sufficient for data collection. Verify the data collection settings.
The wrong dye or detector was selected, or the dye was 
incompatible with the instrument. Be sure the selected 
detectors are appropriate for the fluorescent dyes used.
The Plexor™ Master Mix may have lost activity. Be sure to 
store the Plexor™ qPCR and qRT-PCR Systems at –20°C to 
avoid loss of enzyme activity. Confirm the instrument settings 
and perform a positive control reaction to determine if there 
is a problem with the Plexor™ System reagents.
The primer sequence is incorrect. Verify the primer sequence.
Poor primer design. Redesign primers, targeting a different 
region of the gene of interest. We strongly recommend using 
the Plexor™ Primer Design Software, which is available at: 
www.promega.com/plexorresources/
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VIII. Troubleshooting (continued)

Symptoms Causes and Comments
Flat amplification curve in the Primer was degraded. Use MOPS/EDTA Buffer to resuspend 
amplification curves window and dilute primers. Iso-dC-containing primers are sensitive to 
(no apparent amplification) pH. Rehydrating or storing the primer in water or a buffer 
(continued) with a pH less than 7.0 will result in primer degradation. Do 

not use water to resuspend or dilute primers or make primer 
mixes.
Primers may have been synthesized incorrectly. Resynthesize 
primers.
Primer concentration was incorrect. Verify the primer 
concentration by measuring the absorbance at 260nm.
The scale of the Y axis was inappropriate. If the scale of the 
Y axis is too broad, the change in fluorescence may not be 
visible. Adjust the scale of the Y axis.

Increasing fluorescence over time Excessive template was added to the reactions. Dilute the 
template, and repeat the experiment.
The baseline region was set in a region with significant 
fluorescence fluctuation. The baseline within the baseline 
region should be flat. Manually adjust the baseline region 
(Section IX.D.).
The baseline region was set too close to the signal change. 
Manually adjust the baseline region.(Section X.D.).

Two or more distinct melt curves in For the Plexor™ qRT-PCR Systems, both RNA and DNA 
the melt curves window templates can be amplified. Treat the RNA template with 

RNase-free DNase to eliminate contaminating genomic DNA.
Poor primer specificity. Design new primers with higher 
specificity to the target. To verify primer specificity, perform a
BLAST search with the primer sequence. The primer should 
not exhibit regions of identity with non-target sequences.
Optimize the annealing temperature. Increase the annealing 
temperature by increments of 2°C to reduce the synthesis of 
primer-dimer or nonspecific amplification products.
Pseudogenes or polymorphic genes may exist. Design new 
primers to avoid regions of identity between gene family 
members.
Assemble the reactions on ice to minimize the synthesis of 
primer-dimer or nonspecific product.
Reduce the number of amplification cycles to minimize the 
synthesis of primer-dimer or nonspecific product.
Check for signal bleedthrough. Calibrate the instrument as 
instructed by the manufacturer for the dye set used.
Decrease the primer concentration (e.g., 0.1µM).
Primer pairs in a multiplex reaction can interact to form 
undesired amplification products. Perform a BLAST search to 
reveal regions of identity with undesirable target sequences. 
Label the primer with the lowest homology to other sequences.
Altenatively, design new primers using the Plexor™ Primer 
Design Software, which is available at: 
www.promega.com/plexorresources/
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VIII. Troubleshooting (continued)

Symptoms Causes and Comments
Broad melt curve or a shoulder on Pseudogenes and polymorphic genes may exist. Perform a 
the melt curve BLAST search of the target sequence. When designing 

primers, choose target sequences that have the fewest regions 
of identity with pseudogenes and polymorphic genes.
Check for signal bleedthrough. Calibrate the instrument as 
instructed by the manufacturer for the dye set used.
Decrease the primer concentration (e.g., 0.1µM).
Be sure the thermal cycler is programmed correctly (Section 
III, IV or V)

No melt curve observed in the Poor amplification. See causes and comments for “Flat”
melt curve window amplification curve in the amplification curves window (no

apparent amplification)” above.
Problems with data export or instrument analysis have 
occurred. Review the instructions for data export and 
instrument setup.
Data collection settings were incorrect. Verify the thermal 
cycling program and data collection settings are correct 
(Section III, IV or V).
Incorrect files were imported. Be sure to import the proper 
files containing related amplification data and dissociation data.
Instrument was programmed incorrectly. Verify the thermal 
cycling program is correct (Section III, IV or V).

Variability in signal among Calibrate your pipettes to minimize variability in pipetting.
replicate samples

Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; dilute the template so that larger volumes are 
pipetted.
Some variation is normal. A difference of 1–2 cycles for the Ct

values is within the normal variation associated with an 
exponential amplification reaction.
There will be statistical variation in the amount of template in 
a reaction with targets present at low copy number. Poisson 
distribution predicts difficulty associated with reliable detection
of very dilute samples with few target molecules.
Mixing was inadequate. Vortex reagents to mix well prior to 
pipetting.
Plate performance can differ from manufacturer to 
manufacturer. Use plasticware recommended by the 
instrument manufacturer.
Instrument was improperly calibrated. Calibrate instrument
as instructed by the manufacturer.
Thermal cycling conditions were suboptimal. Optimize the 
annealing temperature.
Thermal cycling conditions were suboptimal. Redesign your 
primers, so the melting temperatures are 60°C. We strongly 
encourage using the Plexor™ Primer Design Software.
Viscous samples (e.g., high-molecular-weight genomic DNA) 
are difficult to pipet accurately. Dilute the DNA template. 
Shear high-molecular-weight DNA by vortexing or pipetting.
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VIII. Troubleshooting (continued)

Symptoms Causes and Comments
Variability in signal among The baseline region was not set correctly. The baseline should 
replicate samples (continued) be flat. The baseline region can be adjusted manually for each 

well to account for sample-to-sample variation (Section X.D.)
The plate was not completely sealed. Carefully seal the plates 
to avoid evaporation.

Fluorescence decrease observed in Nonspecific product can accumulate at higher cycle number in 
the no-template control reactions with targets present at low copy numbers. Assemble

the reactions on ice to reduce the accumulation of nonspecific 
amplification products, including primer-dimer.
Decrease the cycle number to reduce the accumulation of 
nonspecific amplification products.
Primers designed with another primer-design software or for 
another amplification. Design new primers using the Plexor™ 
Primer Design Software.
Reactions were contaminated with target DNA or RNA. Clean 
workstations and pipettes with a mild bleach solution before 
and after use. Use new reagents and solutions. Take 
precautions to prevent contamination (see the Plexor™ qPCR 
System Technical Manual #TM262, the Plexor™ One-Step 
qRT-PCR System Technical Manual #TM263 or the Plexor™ 
Two-Step qRT-PCR System Technical Manual #TM264).
An improperly calibrated instrument can lead to erratic 
fluorescence readings. Calibrate the instrument as instructed 
by the manufacturer.

Vertical fluorescence spikes or Consult the instrument manufacturer’s user’s guide for 
significant “noise” in the information about potential instrument problems that can 
amplification curve cause spikes or noise.

No amplification or poor amplification for the entire plate. 
Poor amplification can lead to improper data scaling, making 
fluorescence measurements appear erratic. See possible causes  
and comments for “Flat amplification curve in the amplification
curves window (no apparent amplification)” above.
Instrument was improperly calibrated. Calibrate instrument
as instructed by the manufacturer.

Small signal change in No amplification or poor amplification. See causes and 
amplification curve and melt comments for “Flat amplification curve in the amplification 
curves curves window (no apparent amplification)” above.

Incorrect filter was selected. Verify the presence of the 
appropriate filter.
Primer concentration was incorrect. Verify primer 
concentration by measuring the absorbance at 260nm.
The scale of the Y axis of the amplification curve is affected by 
other reactions on the plate. A high fluorescent signal for one 
or more reactions can cause the scale of the Y axis of the 
amplification curve to be too high to see changes in some data.
Adjust the scale of the Y axis to accommodate samples with 
smaller changes in fluorescence. See Section VII.C.

tm270.0905.qxp  10/7/2005  9:56 AM  Page 41



VIII. Troubleshooting (continued)

Symptoms Causes and Comments
Nonlinear standard curve, An amplification inhibitor is present in the standard reference 
low R2 values template. Determine whether the template contains inhibitors 

by adding the DNA template to the positive control reaction; 
a significant increase in the Ct value or no amplification of the 
positive control in the presence of the DNA template indicates
the presence of inhibitors. Repeat purification of the standard 
reference template used to generate the standard curve.
Calibrate your pipettes to minimize variability in pipetting.
Small volumes are difficult to pipet accurately. Do not pipet 
volumes <1µl; dilute the template so that larger volumes are 
pipetted.
Viscous samples (e.g., high-molecular-weight genomic DNA) 
are difficult to pipet accurately. Dilute the DNA template. 
Shear high-molecular-weight DNA by vortexing or pipetting.
Adjust the baseline region. The baseline region can be 
manually adjusted for each reaction. See Section X.D.
Some variation is normal. Perform duplicate or triplicate 
reactions for the standard curve to minimize the effect of this 
variation.
There will be statistical variation in the amount of template in 
a reaction with targets present at low copy number. Perform 
duplicate or triplicate reactions for the standard curve.
An error was made during dilution of the standard reference 
template. Verify all calculations, and repeat dilution of the 
standard reference template. Do not pipet volumes <1µl.
Incorrect concentration values were entered in the Plexor™ 
Analysis Software. Verify the concentrations for all samples 
used to generate the standard curve.
Reactions were contaminated with target DNA or RNA. Clean 
workstations and pipettes with a mild bleach solution before 
and after use. Use new reagents and solutions. Take 
precautions to prevent contamination (see the Plexor™ qPCR 
System Technical Manual #TM262, Plexor™ One-Step qRT-PCR 
System Technical Manual #TM263 or Plexor™ Two-Step qRT-PCR 
System Technical Manual #TM264).
The plate was not completely sealed. Carefully seal the plates 
to avoid evaporation.
Aberrant fluorescence can be caused by writing on plates, 
contamination, fingerprints, etc. Do not write on the plate. Use
caution when handling plates. Wear gloves. Do not place plates
on surfaces that might be contaminated with a fluorescent 
material. If you suspect contamination of the benchtop, thermal
cycler block or any other area, clean it thoroughly.
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VIII. Troubleshooting (continued)

Symptoms Causes and Comments
Slope less than 0.2 No amplification or poor amplification. See causes and 
(inefficient amplification) comments for “Flat amplification curve in the amplification 

curves window (no apparent amplification)” above.
Nonspecific amplification can become a problem in later 
amplification cycles with samples containing small amounts of 
target template. Decrease the number of amplification cycles.
Poor primer design. Design new primers.
Annealing temperature is too high. Design new primers with 
melting temperatures of 60°C. We strongly recommend using 
the Plexor™ Primer Design Software.
Annealing temperature is too high. Optimize the annealing 
temperature.

Amplification in no-reverse Contaminating DNA related to the RNA template is present
transcription control for the in the RNA preparation. Treat the RNA template with 
Plexor™ qRT-PCR Systems RNase-free DNase to remove contaminating DNA.

Design new primers to span introns to avoid amplification of 
contaminating genomic DNA.
Assemble reactions on ice to minimize the accumulation of 
nonspecific amplification products, including primer-dimer.
Decrease the number of amplification cycles to reduce 
accumulation of nonspecific amplification products.
Design new primers to minimize the synthesis of nonspecific 
amplification products.
Reactions were contaminated with target DNA or RNA. Clean
workstations and pipettes with a mild bleach solution before 
and after use. Use new reagents and solutions. Use positive-
displacement pipettes or aerosol-resistant tips to reduce cross-
contamination during pipetting. Use a separate work area and
pipette for pre- and postamplification. Wear gloves and change 
them often.

No amplification in the positive No amplification or poor amplification. See causes and 
control reaction comments for “Flat amplification curve in the amplification 

curves window (no apparent amplification)” above.
Verify that the thermal cycling program and data collection 
settings are correct (Sections III, IV or V).
Instrument setup problems can cause amplifications to fail. 
Consult the instrument manufacturer’s user's guide for more 
information about potential instrument problems.
The Plexor™ Master Mix may have lost activity. Be sure to 
store the Plexor™ qPCR and qRT-PCR Systems at –20°C to 
avoid loss of enzyme activity. Confirm the instrument settings, 
and perform a positive control reaction to determine if there is
a problem with the Plexor™ System reagents.
The RNA template used in the Plexor™ qRT-PCR System was 
contaminated with ribonuclease (RNase). Take precautions to 
prevent RNase contamination. Clean workstations and pipettes
with a mild bleach solution before and after use. Use new 
reagents and solutions.
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VIII. Troubleshooting (continued)

Symptoms Causes and Comments
No amplification in the positive The RNA template used in the Plexor™ qRT-PCR Systems was 
control reaction (continued) degraded. RNA storage conditions are very important. Store 

RNA template at –70°C in single-use aliquots to minimize the
number of freeze-thaw cycles. Once thawed, keep RNA on ice.
Always use nuclease-free, commercially autoclaved reaction 
tubes, sterile aerosol-resistant tips and gloves to minimize 
RNase contamination.
Reactions were assembled incorrectly. Repeat the experiment 
and assemble reactions as described in the Plexor™ qPCR 
System Technical Manual #TM262, Plexor™ One-Step qRT-PCR 
System Technical Manual #TM263 or Plexor™ Two-Step qRT-PCR 
System Technical Manual #TM264.

Unable to import data. An error The data has been altered after export from the real-time PCR
like “Expecting NEWLINE, instrument software. Any alteration of this data is likely to 
found’’” or “Unexpected Token change the formatting and can cause import errors. Do not 
Error” is encountered open the exported files with other software programs.
Data display appears abnormal in Be sure that the display settings for the computer are set to
the Plexor™ Analysis Software 32-bit color, rather than 16-bit color, when using the Plexor™
(the screen appears compressed, Analysis Software.
lines are replaced with dots, etc.)
Genotyping: Miscalled known Poor primer design. Redesign primers. We strongly recommend
heterozygous samples: Product using the Plexor™ Primer Design Software, which is available 
formed with only one of the two at: www.promega.com/plexorresources/
genotyping primers

The annealing temperature is too high or too low. Optimize 
the annealing temperature.

Genotyping: Miscalled known Poor primer design. Redesign your primers. We strongly 
homozygous samples: Product recommend using the Plexor™ Primer Design Software, which
formed (signal decrease) with is available at: www.promega.com/plexorresources/
both primers The annealing temperature is too low. Optimize the annealing

temperature.
Reactions were assembled incorrectly. Verify that the 
appropriate primer pairs were added

Genotyping: Miscalled known The primer sequence was incorrect. Verify that the primer 
homozygous samples: Product sequence is correct.
formed only with the mismatched 
primer but not with the matching 
primer

Genotyping primer #1 and primer #2 were switched. Verify 
that the correct primer was used.

Genotyping: No call Add more template. Redesign primers. See comments for 
“Flat amplification curve in the amplification curves window 
(no apparent amplification)”.
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IX. Appendix

IX.A. Plexor™ Analysis Software Operating System Compatibility

The Plexor™ Analysis Software is compatible with the following operating systems:
Windows® 98, Windows NT® 4, Windows® ME, Windows® XP and Windows® 2000.
Other operating systems are not supported. The Plexor™ Analysis Software is not
compatible with Macintosh® computers.

Be sure that the display settings for the computer are set to 32-bit color, rather than
16-bit color, when using the Plexor™ Analysis Software.

IX.B. Plexor™ Analysis Software Installation

The Plexor™ Analysis Software and installation instructions are available for
download at: www.promega.com/plexorresources/. The software is also available
free-of-charge on CD-ROM by request. Consult the Promega Web site to verify that
you are installing the most recent version of the software. Following installation, the
program can be accessed in the “Start” menu: Programs\Plexor\Analysis Desktop.

Instructions for Installing the Plexor™ Analysis Software from CD-ROM

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the “Plexor.exe” installer icon on the CD-ROM and follow
the on-screen instructions to install the software.
Note: Installation of the software may take several minutes. There is a
pause where the computer may appear to be inactive between the launch
of the installer and the software installation.

IX.C. Advanced Options

At the “File Import” screen, Step 3 (Figure 18, Figure 27), there are two “Advanced
Options” buttons: “Run Template” and “Analysis Template”. These options allow
plate configuration and assay parameter information to be saved for reuse during
routine experiments.

Run Template: A run template is used to assign sample types, sample colors and
concentrations of standards (Figure 41). If you routinely use the same setup for
plates of standard samples and unknowns, a run template can be created, stored
and applied to subsequent runs.

1. Select “Run Template”.

2. Assign colors, sample types and concentrations to the standards in the
“Plate Setup” tab.

3. Use the “Sample IDs” tab to label your samples. Simply select the sample
you wish to name and start typing.

4. Select “Export” to save the plate configuration to a *.rtp file for later use.

5. Select “OK”.

To import an existing *.rtp file that contains a saved plate configuration, select
“Import” and browse to that file.
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Figure 41. A Run Template.

Analysis Template and Definition of Analysis Functions: The analysis template is
used to optimize the analysis settings for the experiment. If you routinely perform
reactions with the same analysis conditions, an analysis template can be created,
stored and applied to subsequent runs. These settings can be exported as a *.ntp file,
then imported for subsequent experiments. A description of the functions for each
setting follows.

1. Select “Analysis Template”.

2. Enter the desired values for the analysis defaults for each dye used 
(Figure 42).
Note: Descriptions of the analysis details are provided below.

3. Select “Export” to save the default settings to a *.ntp file for later use.

4. Select “OK”.

To import an existing *.ntp file that contains the saved default settings, select
“Import” and browse to that file.

Default Amplification Threshold (RFU) Baseline Noise Standard Deviations: The
Plexor™ Analysis Software has a user-definable amplification threshold that
determines the RFU value at which sample cycle thresholds are called.

This value is based on the variation (noise) in the baseline regions of all samples and
is determined by taking the mean and standard deviation of all RFUs in baseline
regions. The threshold is set a specified number of standard deviations below the
mean. The default threshold is 10 standard deviations but can be changed in the
Analysis Template or recalculated at any time by using “Set Amp Threshold from
Selected Samples” option in the “Edit” menu (See Section VII.D.).
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Figure 42. The Analysis Defaults tab.

Default Melt Threshold –d(RFU)/dT Percentage: The melt curve allows you to
distinguish amplification products with different sequences and lengths. In the
absence of nonspecific amplification products, the melt curve will have one peak.
Each sample has a melt curve, from which a Tm can be determined. A Tm value is
reported for all melt curves that cross the melt threshold. The melt threshold
represents the –d(RFU)/dT value that is required before a Tm value is reported for 
a sample. A sample’s Tm value is calculated as the temperature at which the melt
curve has the lowest (i.e., the most negative) –d(RFU)/dT value.

The default melt threshold –d(RFU)/dT percentage is preset at 25.0% and can be set
between 0.0 and 100.0%. This value is used by the software to calculate the melt
threshold value. The Tm threshold value is defined as a percent of the –d(RFU)/dT
value for the sample with the lowest –d(RFU)/dT value in the data set.

The melt threshold value is recalculated when a standard curve is generated. The
melt threshold value can be manually adjusted by clicking and dragging the
horizontal melt threshold line.

Expected Target Melt Temperature: The expected target melt temperature is the melt
temperature of the correct PCR product. The expected target melt temperature must
be between 65°C and 95°C. The default expected target melt temperature is 90°C.

Target Tm Upper Bound: The target Tm upper bound is the number of degrees
Celsius above the expected target melt temperature at which a sample Tm is
considered to be suspect. The default target Tm upper bound is +1°C.

Target Tm Lower Bound: The target Tm lower bound is the number of degrees
Celsius below the expected target melt temperature at which a sample Tm is
considered to be suspect. The default target Tm lower bound is –1°C.
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Figure 43. An amplification window showing the baseline region and baseline upper and lower
limits.

IX.D.Manual Baseline Adjustments

The proper baseline region is important for optimal analysis of Plexor™ System
data. Baseline regions are automatically determined during import of data into the
Plexor™ Analysis Software.

The baseline region is set in a flat region of the amplification curve before the
beginning of the downward inflection that indicates product accumulation. In some
instances, manual adjustment may provide optimal representation of the data. This
may include samples with excessive noise, bleedthrough or early Ct values or
situations where the real time instrument shows early signal fluctuation.

1. Select the “PCR Curves” tab.

2. Select the “Display and Manually Adjust Baselines” icon:

3. Select the samples to be adjusted using the well selector.
Note: The baseline region can be adjusted for individual samples or
groups of samples by selecting or dragging the lower and upper limits.
The shading in the baseline region will be gray if the selected samples do
not share a common baseline region (Figure 43). For multiplex assays, the
baseline is set independently for each dye.

4. Adjust the upper limit of the baseline region for each sample, so the upper
limit is approximately 5 cycles before the decrease in fluorescence and in
an area where the baseline is flat. The Ct values for selected samples are
displayed in the table to the right of the graph. The Ct value may change
when the limits are changed. See Notes 1 and 2.

5. If necessary, adjust the lower limit to a region that creates the flattest
baseline given the selected upper limit.

6. Optional: The amplification threshold is based on noise within the
baseline region for all of the samples. When manual baseline adjustments
are complete, consider recalculating the amplification threshold for all
samples. Select all samples, and in the “Edit” menu, select “Set Amp
Threshold from Selected Samples” (Section VII.D.). See Notes 3 and 4.
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Notes:
1. A maximum upper limit of 35 cycles can be used for samples without a Ct

value (e.g., no-template control).

2. Samples with similar Ct values can be adjusted simultaneously by
highlighting multiple wells.

3. The baselines for all samples can be reset to the automatic setting by
selecting the “Reset Baselines and Amp Thresholds” icon:

4. To reset the baselines for a selected set of samples, select the samples in
the well selector, and in the “Edit” menu, select “Set Baselines for Selected
Samples”.

IX.E. Icon Definitions

Assign Color (shortcut = “q”)

The “Assign Color” function allows you to select a color in which a sample is
displayed. This color selection is associated with those samples in the amplification
and melt curves, well selector and any reports. Select one or more wells using the
well selector, then select this button to choose the desired color for the selected
samples. These colors are not transferred to printed copies or exported reports.
Sample color does not change the analysis of a sample in any way.

Assign Unknown (shortcut = “w”)

The “Assign Unknown” function allows you to assign the sample type “Unknown”
to all selected samples. Select one or more wells using the well selector, then select
this button to assign the sample type “Unknown”. Unknown samples are displayed
as open squares in the well selector. They are labeled “Unknown” in reports. When
included in a standard curve, the concentrations of unknown samples will be
calculated and reported.

Assign NTC (shortcut = “e”)

The “Assign NTC” function allows you to assign the sample type “No Template
Control” to all selected samples. Select one or more wells using the well selector,
then select this button to assign the sample type “No Template Control”. No-template
control reactions are displayed as diamonds in the well selector. They are labeled as
“No Template Control” in reports. When included in a standard curve, the
concentration of sample in the no-template control will be calculated and reported.

Assign Positive Control (shortcut = “t”)

The “Assign Positive Control” function allows you to assign the sample type
“Positive Control” to all selected samples. Select one or more wells using the well
selector, then select this button to assign the sample type “Positive Control”.
Positive control samples are displayed as hexagons in the well selector. They are
labeled “Positive Control” in reports. When included in a standard curve, the
concentrations of positive control samples will be calculated and reported.
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Assign Standard (shortcut = “r”)

The “Assign Standard” function allows you to assign the sample type “standard” to
all selected samples. Select one or more wells using the well selector, then select this
button to assign the sample type “standard”. Only samples that have been assigned
a type of “standard” will be used to generate the best-fit line in standard curves. All
standard samples must be assigned a concentration by the user when they are defined
as a standard. Concentrations may be entered in standard format (0.01, 0.1, 1, 10, 100,
1000, etc.) or scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3, etc.). The software does
not accept commas in the concentration assignments. Standard samples are displayed
as circles in the well selector and standard curve graphs. They are labeled “standard”
in reports.

Create Dilution Series (shortcut = “f”)

The “Create Dilution Series” function creates a full dilution series within a row or
column of wells. Select the wells that contain a dilution series of the standard, then
select “Create Dilution Series”. You must enter the initial concentration of the series,
the dilution factor and whether the series is increasing or decreasing (Figure 20).
Concentrations may be entered in standard format (0.01, 0.1, 1, 10, 100, 1000, etc.) or
scientific format (1e-2, 1e-1, 1e0, 1e1, 1e2, 1e3, etc.). The software does not accept
commas in the concentration assignments.

All selected wells will be assigned the sample type “standard” with the appropriate
concentration. This function can only be performed with standards within the same
row or column. Using this function produces the same result as selecting each well
in the series individually and assigning it the sample type “standard” with the
appropriate concentration. Only samples that have been assigned the sample type
“standard” will be used to generate the best-fit line in standard curves. Standard
samples are displayed as circles. A row or column of wells within a dilution series
of standards may be assigned as standards simultaneously by highlighting multiple
wells and using the “Create Dilution Series” function.

Add Standard Curve (shortcut = “d”)

The “Add Standard Curve” function fits the experimentally measured Ct values and
user-entered concentration values for standard samples to a straight line using the
least mean squares method. It will calculate the concentrations of unknown samples,
positive control reactions and no-template control reactions from their measured Ct

values using the equation for the best-fit line. Any sample with a concentration of
“N/A” on the report or elsewhere did not cross the cycle threshold, so the
concentration of that sample cannot be calculated.

Select all of the samples you wish to use as standard samples, as well as all other
samples for which you wish to calculate concentrations. Choose “Add Standard
Curve” from the “Edit” menu. Type “d” or select the “Add Standard Curve” icon 
on the toolbar.

You may create as many standard curves as you wish for a single set of data, but no
sample can be used to generate more than one standard curve. It is not possible to
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add samples to an existing standard curve, but a new curve can easily be
constructed with a new selection. This action will remove the existing standard
curve and generate the new standard curve using the samples you have selected.
You may generate the original standard curve at any time.

Remove Standard Curve (shortcut = “c”)

The “Remove Standard Curve” function removes the standard curve on the tab that
is currently selected. This function is only available in the “Standard Curves” tab.

Display and Manually Adjust Baselines

The “Display and Manually Adjust Baselines” function allows you to set the
baseline range for a sample or set of samples. Select one or more wells using the
well selector, then select this button. See Section VIII.D.

Reset Baselines and Amp Thresholds

The “Reset Baselines and Amp Thresholds” function allows you to reset the baseline
range and amplification threshold for all samples. See Section X.C.

IX.F. Amplification Efficiency Calculations

The Plexor™ Analysis Software automatically calculates the equation for the best fit
line and determines the R2 value of the standard curve. The R2 value is a measure of
the fit of the data points to a straight line. An R2 value of 1.0 is a perfect fit. R2 values
should be close to 1.0.

The software also calculates the slope of the standard curve. The slope is an indication
of the efficiency of the PCR. At 100% efficiency, the amount of amplification product
doubles with every cycle, so Ct values differ by 1 for each twofold dilution of the
template. At 100% efficiency, the amount of product increases tenfold every 3.32 cycles
(23.32 = 10), so Ct values differ by 3.32 for each tenfold dilution. A reaction with 100%
efficiency will have a slope of –3.32 when the amplification curve is displayed with
the Ct values on the Y axis and log concentration on the X axis. When the
amplification curve is displayed as Ct versus log concentration, the efficiency may
be calculated as [(10-1/slope) -1] × 100% (1).

IX.G.Use of an External Well Factor Plate

Materials to Be Supplied By the User
• Bio-Rad 10X Well Factor Solution

The Bio-Rad iCycler iQ™ performs a “well factor” collection process at the onset of
a run to normalize signal across a plate. During the final steps before starting a run
(before cycling begins), the iCycler IQ™ will require designation of the experimental
plate or an external well factor plate as the source of this data. Use of the
“experimental plate” (the simplest and recommended method) requires that the
selected wells all contain the same concentrations of dyes. 

If not all wells share the same dyes and dye concentrations, an external well factor
plate must be used. For example, if the Plexor™ System positive control reaction
(FAM-labeled primer only) were to be run on the same plate as a multiplex assay,
an external well factor plate would be required.  
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Bio-Rad supplies a 10X External Well Factor Solution to be used for creation of an
external well factor plate. The process of creating an external well factor plate is
described below.

Note: If an external well factor plate is being used for qPCR or Two-Step RT-PCR
(Section III) or Genotyping/SNP detection assays (Section V) the thermal cycling
protocol must be modified to include a 2:00 minute initial denaturation. The thermal
cycling protocols described in Sections III and V of this technical manual  include a
30 second initial denaturation that factors in the assumed internal well factor data
collection that is automatically inserted by the iCycler iQ™ software. This inserted
function is a 90-second process at denaturing temperatures.

Setup of an External Well Factor Plate

1. Dilute the 10X External Well Factor Solution to 1X in ddH2O. Twenty five
microliters of this 1X solution are required for each well used in the
experimental plate (with additional volume prepared for pipetting
variation). Dilute 300µl of 10X External Well Factor Solution in 2.7ml water
for one plate.

2. Aliquot 25µl (volume equal to the amplification reactions) to an empty
plate. Well positions not used in the plate setup process (III.B, IV.B and
V.B) do not need this solution.

3. Seal plate and centrifuge briefly.

4. In the “Run Prep” window that opens, enter 25 for “Reaction Volume”
and select the “Well Factor Plate” radio button for the “Select well factor
source” option. Place the Well factor plate into the instrument and
immediately begin the run by pressing the “Begin Run” button. Keep the
experimental plate on ice.

5. After several minutes, you will be promted to remove the well factor plate
and insert the experimental plate. Select “continue” when the
experimental platehas been placed into the instrument and the lid has
been closed.

Further details on use of a well-factor plate are available in the iCycler
iQ™ instrument manual.

IX.H.Reference

1. Bustin, S.A. (2004) A–Z of quantitative PCR. International University Line, La Jolla.
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(a)The PCR process, which is the subject of European Pat. Nos. 201,184 and 200,362 owned by Hoffmann-LaRoche*, is
covered by patents issued and applicable in certain countries. Promega does not encourage or support the unauthorized or
unlicensed use of the PCR process. Use of this product is recommended for persons that either have a license to perform
PCR or are not required to obtain a license.

*The above primary European Pat. Nos. 201,184 and 200,362 will expire on March 28, 2006. In the U.S., the patents covering
the foundational PCR process expired on March 29, 2005. 

(b)The purchase of this product conveys to the buyer the limited, non-exclusive, non-transferable right (without the right to
resell, repackage, or further sublicense) under U.S. Published Patent Appln. 20020150900 and U.S. Pat. Nos. 5,432,272,
6,617,106 and 6,140,496 to use the product. No other license is granted to the buyer whether expressly, by implication, by
estoppel or otherwise. In particular, the purchase of this product does not include or carry any right or license to sell this
product. For information on purchasing a license for other uses, please contact Promega Corporation, Licensing, 2800
Woods Hollow Road, Madison, WI 53711 or EraGen Biosciences, Corporate Licensing, 918 Deming Way, Suite 201, Madison,
WI 53717. Phone (608) 662-9000; Fax (608) 662-9003.

© 2005 Promega Corporation. All rights reserved.

RNasin is a registered trademark of Promega Corporation. ImProm II and Plexor are trademarks of Promega Corporation.

iCycler iQ is a trademark of Bio-Rad Laboratories, Inc. Macintosh is a registered trademark of Apple Computer, Inc.
Microsoft, Excel, Windows and Windows NT are registered trademarks of Microsoft Corporation. 

Products may be covered by pending or issued patents or may have certain limitations. Please visit our Web site for more
information.

All prices and specifications are subject to change without prior notice.

Product claims are subject to change. Please contact Promega Technical Services or access the Promega online catalog for the
most up-to-date information on Promega products.

tm270.0905.qxp  10/7/2005  9:57 AM  Page 53


	I. Description
	II. Plate Preparation and Amplification
	III. Instrument Setup and Thermal Cycling for qPCR and Two-Step qRT-PCR
	III.A.Thermal Cycling Program
	III.B. Plate Setup

	IV. Instrument Setup and Thermal Cycling for One-Step qRT-PCR
	IV.A. Thermal Cycling Program
	IV.B. Plate Setup

	V. Instrument Setup and Thermal Cycling for Genotyping (SNP) Assays
	V.A. Thermal Cycling Program
	V.B. Plate Setup

	VI. Data Export from the iCycler iQ™ and Import into the Plexor™ Analysis Software
	VI.A. Pasting Data Directly into the Plexor™ Software
	VI.B. Data Export and Import via Excel

	VII. Data Analysis with the Plexor™ Analysis Software
	VII.A. Sample Definition
	VII.B. Adjusting the Expected Target Melt Temperature
	VII.C. Adjusting the Y Axes of the Amplification and Thermal Melt Curves (Optional)
	VII.D. Adjusting the Baseline Region and Amplification Threshold Line (Optional)
	VII.E. Generating a Standard Curve (Optional)
	VII.F. Reports
	VII.G. Saving and Printing the Analysis File

	VIII. Troubleshooting
	IX. Appendix
	IX.A. Plexor™ Analysis Software Operating System Compatibility
	IX.B. Plexor™ Analysis Software Installation
	IX.C. Advanced Options
	IX.D.Manual Baseline Adjustments
	IX.E. Icon Definitions
	IX.F. Amplification Efficiency Calculations
	IX.G.Use of an External Well Factor Plate
	IX.H.Reference




